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SUMMARY 

 

Some of the radionuclides, that had been released to the atmosphere from the 

Fukushima Dai-ichi Nuclear Power Plant (FDNPP) accident, were transported to the 

Korean territory and began to be detected on March 28, 2011 at some regional 

environmental monitoring stations of Korea and continued to be detected until May 

31, 2011 (Kim et al., 2012). The radioactivity of 131I, 134Cs and 137Cs in aerosols and 

rainwater reached peak values on April 6, 2011 at the Jeju monitoring station which 

is located in the northern region of Jeju Island. Jeju Island is the largest island of 

Korea located about 100 km distant in southwest direction from the southern end of 

the Koran peninsula. Radionuclides of the highly volatile elements I and Cs are 

released into the atmosphere in early stages of a nuclear reactor core melt-down 

accident and carried away long distance from the accident place, and thus they have 

been frequently used for tracing and evaluating the radiological impact from an 

nuclear power plant accident or an open air nuclear bomb test by which a large 

amount of radioactive fission products is released to the atmosphere (Aoyama et al., 

1987, Molero et al., 1999, Pittauerova et al., 2011, Tagami et al., 2011). 131I has a 

very short half-life (≈ 8 d) and thus it can be traced only for a short period of time 

after an accident. The half-life of 134Cs is about 2 years so that it can be traced for 

several years after an accident. The half-life of 137Cs is long enough (≈ 30 a) to be 

traced for several tens of years. Tremendous amounts of 137 Cs were released into the 

atmosphere by open air nuclear bomb tests conducted during 50’s and 60’s and by 

the Chernobyl nuclear disaster occurred in 1986. Since the released 137Cs had spread 
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out over the world and deposited on the ground, the most surface soils in the world 

generally have substantial inventory of 137Cs. Lee et al. (1998) reported the 

distribution of 137Cs in soils of many regions of Koran peninsula except for Jeju 

Island. As the time passes after the accident, radionuclides with short half-lives such 

as 131I are no longer measurable above minimum detectable limit (MDA). Instead 

134Cs and 137Cs have become prime radionuclides used for assessing the radiological 

consequences of the Fukushima accident. Since both nuclides are chemically 

identical, the radioactivity ratio of 134Cs and 137Cs depends on the burnup of the 

damaged nuclear fuel. Hence it is specific to a particular accident and remains 

unchained if decay correction is properly made. The initial radioactivity ratio was 0.5 

to 0.6 during the Chernobyl accident, and it was about 1.0 for the Fukushima 

accident. 

No attempt has been yet made to assess the radiological impact on the soil of Jeju 

Island from the FDNPP accident. About 7 months after the accident, we have 

selected 12 locations in Jeju Island and collected at each location a sample of surface 

soil and mosses growing on nearby stones and rocks. We measure specific activities 

of 134Cs and 137Cs in the surface soil and moss samples by gamma-ray spectrometry 

and estimate the amount of 137Cs in the soil originating from FDNPP accident. 

Activity profiles of 134Cs and 137Cs are obtained for a cored soil sample to see the 

migration behavior of both nuclides.  

Specific activities of 134Cs and 137Cs in the surface soil vary from less than MDA 

to 17 Bq/kg and from 12 Bq/kg to 109 Bq/kg, respectively. Specific activities of 

134Cs and 137Cs in moss samples lie in the range 6 Bq/kg to 39 Bq/kg and 15 Bq/kg to 

41 Bq/kg, respectively. The activity ratios 134Cs/137Cs in the soil samples are much 
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less than the reference value of about 1.0, but they are close to 1.0 in the moss 

samples. Average amount of 137Cs added to the surface soil after the Fukushima 

accident is estimated to be 7.8 ± 1.7 Bq/kg. The depth profile of 137Cs specific 

activity has a lognormal shape with a peak between 5 cm and 7.5 cm below the 

ground. For the cored soil sample, 134Cs was detected up to 3 cm below the ground. 
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I.    

 

원자 소  가동과 연구 , 료   산업체 등에  사  질  

사용 증가에 라 자연 경  사  염 가능 이 증 고 있다. 특히 1979

 미국에  일어난 TMI 원자  소 사고  1986  4월 26일 구 소  체르노

 원자  소 사고  인 여 사 핵종이   산 어 이동  후, 

 에 부 거나 지 면에 침착 다.  2011  3월 11일 규모 9.0  

지진이 생 고, 이어 10미 가 는 쓰나미가 동북부 일본 해  강타

여 후쿠시마 원자 소  1,3,4  건 이 손상 었고, 이  인 여 핵  

생 이 외부  출  시작 여 미국이나 럽  계 각국  퍼 나갔

다. 실  국원자 원(KINS: Korea Institute of Nuclear Safety)에  

실시  경 사능  결과를 보면 국내에 는 2011  3월 24일부  춘천에

  시작했 며, 4월 5일부  국내  지역에  었다. 이 듯 

경 에는 이미 인공 사 핵종이 존재 고 있 며, 계 여러 나라에  경

사 에  연구뿐만 니라 사능 염사고  가능 에 여 자국  

사능 염사고는  인 국  사고  인  자국  사능 염에 는 감

시체계를 운 고 있 며, 국내  경우에 감시망 운   사능 소인 

KINS  심  인구 지역  지역   등  고  12개소 지역( 울, 

부산, 구, , 주, 춘천, 군산, 주, 강릉, 동, 원, 청주)에  지

소  울릉도  도 등에  25개 간이 소  산 를 통  

집 식  리 고 있다.   

편, 일  경토양에  견 는 슘동 원소는 핵분열생  시 그 생

  출 가 다른 인공핵종들보다 높  에 경 사능 감시에 주요 목  
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핵종  취 고 있다. 그리고 137Cs  포타슘과  질이 슷 여 인체

 쉽게 이동 는데 특히 생식 (gonad)에 쉽게 침 다.  134Cs는 베타 붕

여 604.72 keV  특 감마  사 고  134Ba이 다.  이는 많  양

이 인체에 들어 면 불임증, 신마 , 내장, 갑상 , 골  등    

있다. 이 게 원 사고 시 출 는  핵종  볼  있는 134Cs  137Cs  

토양에 착이 잘 며, 이 용이  감마  출 고, 시료 처리가  

간단  편이어  본 연구에 목  핵종  다. 특히 토양에 침착 여 잘 

움직이지  에 10  이상 지도 이 가능 다. 그러므  경 에  

 슘   후쿠시마 원 사고 당시 출  슘  를 여 재 

존재 는 경  슘  원  인   있다.  

 토양에  사  핵종 착도는 사  핵종농도  산 상태, 토양  

pH     리간드 함량에 존  뿐만 니라 강우량, 토양  종  

 식  등  지역  특 에도 존 다.  이 게 변 가 많지만 토양  쉽게 구

  있고, 착 이 좋  경에 존재 는 사  낙 질  검출   

인 경시료 써 사용 고 있다. 그리고 이끼  지 도 사  핵종  

잘 는 특  가지고 있  것  사료 는 시료들이다. 라  본 연구를 

통 여 동일  지역에  채취  토양시료  이끼시료  사능 농도  함

써, 이끼시료  경 사능분  시료 써  효용  단 고자 다. 

늘날에는   질 염과 같  생 경에  국민  심  높

지고 있는 것과 불어 사능에  경 염에  심  높 지고 있

다. 라 , 상시에  경 사  베이스라인 data를 충분히 보 는 

연구는 우리나라에  직 인 사능 염사고가 없 라도 인 국  사능 

염사고 가능 에   있고, 국민들  불 감 해소에 도움   것이다.  
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본 연구에 는 토양시료  이끼시료 에 포함  134Cs  137Cs  사능 농

도를 분  여 시료채집 지역  주도 지역에  12개 지역  택

다. 시료  채취는 2011  11월 1부  2012  11월 15일 지 2주간이었다. 

채취  각각  시료는 실험실에  처리 과  거쳐 U-8용 에 충진  후, 높

이  게를 인 고 고 도게르마늄검출 (HPGe)를 이용 여 분 다.  

134Cs  137Cs  를 계산 여 재 존재 는 슘  원  인 다. 
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II. 이  경 

 

 

1.  경 사능  개요 

 

자연계에 존재 는 질  그 질  원자핵이 불 해지면 스스   

는 질  갖고 있다. 자연계  많  핵종  보면 체  핵  양 자  

자 가 같거나 슷 다. 만약 핵이 양 자에 해 자가 불 요 게 많

거나 역  부족 면, 그 핵  불 해지면  에 지를 내보내고  

는데, 이  내보내는 에 지가 곧 사 이다. 즉, 사 이란 에 지  름이다. 

그리고 이 게 불 여 사  내보내 는 질  사 이라 다. 사

질  자연  는 인  생 여 우리 경에 존재 게 다.  

우리가 살 가면  게 는 사  폭원에는 가지가 있는데, 그 첫 번째

는 우주 (cosmic ray), 지각구  사 질(우라늄, 토륨  그 붕 생 )  

인체구  사 질 등  자연 사 원에  폭이다. 인간이 경과 불어

 살 가고 있  에 자연 사 에  폭    없 며, 인 는 자

연 사 과 함께 생 고 진 해가고 있다.  번째 폭원  료  진단 사

, 핵실험에  낙진, 원자  시  등 부  출 어 나 는 인공 사

이다. 인  명이 함에 라  이러  자연 사 과 인공 사 에  

폭이 증가 고 있  에, 각종 사  핵종에  경 염 도를 

게 평가   있어야 사능에  생 인 해를  일  있  것

이며 상  게 일어날 도 있는 핵사고를   있  것이라고 생각

다. 
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1.1 자연 사 원  

 

1) 지구 원 사  핵종 

지구가 생  에 핵 합 동에 해 모든 종  사 핵종이 생

었다. 지구가 생  후 냉각 어 가면  45억  시간이 르는 동  단 감

 핵종  차 소멸 고 재 남 있는 지구 원  핵종  감 가 10억  

이상  것들과 이들  붕  산 인 핵종들이다.  

자연 사  핵종  붕 계열  이루는 것과 그 지  것  나   있다. 

붕 계열  이루는 사능  모핵종에 라 238U  우라늄 계열(4n+2), 235U  

티늄 계열(4n+3)  232Th  토륨 계열(4n+0)이 있 며, 241Pu  튜니움 계열

(4n+1)  이미 거  붕 소멸 고 209Bi 만이 존재 다. 이들  Fig. 1  238U 붕

계열도에  보는  같이 붕  베타붕 를 복 며 원소 납  

변해간다. 이  붕  시 질량 가 4  감소 므  4   나 지  질량

 변  나타낸다.  

238U  가장 거운 자연원소이며 붕 산 일 234U  함께 거  사평  이

루고 있다. 238U, 234U, 235U  자연 존재 는 99.27%, 0.0057%, 0.72% 이다. 238U 붕

계열에  핵종인 226Ra, 222Rn, 210Pb, 210Po 등이 인 자연 사 핵종  존

재 다. 이  라듐  붕 산 인 222Rn  체상  변함 써   

출 이동   있다. 지구 원 사 핵종  지각과 토양에 주  존재 고, 일부

는 부  는 가스상  출 어  에 존재 다.  이들  이나 

지 에 용출  용해 어 지 , 지   해 에 분포 게 다. 자연 사

능  자연 상태에 존재해 므  이에  향  인간이 생  면   

 없다. 그러나 근래 산업 과 인간  동에 해 자연 상태보다 높  
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 농축  자연 사능(TENORM: Technically Enhanced NORM)에  심이 높

지고 있다.  

 

 

Fig. 1.  Uranium decay series. Vertical and diagonal arrows represent α- and  β-

decay, respectively. 
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Fig. 2.  Thorium decay series. Vertical and diagonal arrows represent α- and  β-

decay, respectively. 
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Fig. 3.  Actinium decay series. Vertical and diagonal arrows represent α- and  β-

decay, respectively. 
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2) 우주 원 사 핵종 

고 에 지  우주 이 지구  외각 부  권  입사해 들어 고 있다. 

이 1차 우주 이 에 부 쳐   질과 작용 여 2차 우주  생

면  사 질  만들어낸다.  주 분인 질소  산소가 쇄(spallation)

  14N(n, p)14C 등   일 키며 생 는 쇄  생 는 14C, 7Be, 

3H 등  들  있다. 우주  작용에 여 생  사 핵종  종 는 Table 

1에 나타내었다. 

 

Table 1.  Natural Radionuclide originated from cosmic ray 

Nuclide Half-life Nuclide Half-life 

3H 12.3 y 32P 14.3 d 

7Be 53 d 33P 25 d 

10Be 2.5x106 y 35P 8 d 

4C 5,730 y 38S 2.9 h 

22Ns 2.6 y 34mCl 32.0 m 

24Ns 15 h 36Cl 3.1x105 y 

28Mg 21.2 h 38Cl 37.3 m 

26Al 7.4x105 y 37Cl 55.5 m 

31Si 2.6 h 39Ar 270 y 

32Si 700 y 81Kr 2.1x105 y 

 

 

 에  보는  같이 우주 원 핵종  부분 가벼운 원소들이며 감

는 32분(32mCl)에  250만 에 이른다. 단 감  핵종  지상에 침 여 생태

계에 들어가  에 소멸 다. 이들  붕   침  경  향  지상  고
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도에 라 핵종 농도는 큰 폭  변 다.  권과 권  높이 변  

에 도에 라 생 도 달라진다. 14C과 3H  인 우주 원 핵종  

사  생태 인 면에  요 다. 7Be  권과 권 상부에  생

어 입자상  장 면  히 지 에 침착 다. 침착과 에   이동과 

산  향  므  7Be 입자크  사능량  변동  체 시간 추  

추 자  사용 도 다. 우주 원 사능  지각에 침 거나 에 용해

어 권에 퍼 나가게 다. 라   등  리  모델  연구 는 데는 

22Na를 추 자  사용  도 있다.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

20 

 

 

1.2 인공 사 원 

 

 1941  12월에 착  맨 탄 트  결과  1945  여름 3개  원자탄

 다. 1945  7월 16일 미국  뉴 시 주 사막에  첫 권 핵폭

 실험이 공 며, 이것이 인공 사능이 지구 규모  산 게  첫 사건

이다. 1945  이래 지구상  권 핵실험   543회 시행 었다. 권 핵

실험  1950  후 과 1960  에 걸쳐 가장 번히 실시 었다.  이  

생  사 질  에  송, 산  지 면에 강 었다.  

핵  연쇄 에  원자탄이 폭 여 생  에 지  50%는 폭풍 , 

30%는 열 , 15% 도는 사 에 지  출 다. 생 는 사  핵종  

부분 핵분열 에 해 생 며, 그 는 200여종에 이른다. 이들 핵종  

경에  검출  도   가진 핵종  질량  72에  161 지  핵종들이

다. 그 에 도 90Sr과 137Cs이 량 추  상 특히 주목 고 있는 핵종이며, 이

외에 주요 사  핵종 는 3H, 14C, 55Fe, 85Kr, 239Pu, 240Pu 등이 있다.  

핵분열 생  경에 출   있는 시 는 원자 소, 재처리시 , 

폐 처분장 등이 있다. 우리나라는 재처리시 이 없고, 처분장도 건 단계에 

있 므  재 사 질  출 고 있는 주요 시  원자 소이다. 원자

 소 등에  생 는 주용 사  핵종  3H, 14C, 41Ar, 51Cr, 54Mn, 58Co, 

60Co, 89Sr, 85Kr, 95Zr-Nb, 103Ru-Rh, 106Ru, 131I, 133Xe, 134Cs, 137Cs, 141Ce 등

이다.  Fig 4는 137Cs  붕  도식도를 나타내고, Fig 5는 슘동 원소  핵  

붕 도를 나타낸다(Shigeo Ohki, 2002) 
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Fig. 4.  Decay scheme of 137Cs. 

 

 

 

Fig. 5.  Nuclear reaction chain for cesium isotopes. 
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1) 체르노 사고 

1986  4월 26일 체르노  원  4   출  시험 에 사고가 생

다. 원자  불  운  통 가 불가능  출 상승이 일어나 스 계

통이 폭 고 이어  원자  노심과 건  지붕이 날 갔다. 이후  원

자 에  10일간에 걸쳐 사능이 출 었다. 이 사고에   에 출  

사능량  히 시마 원폭에  것보다 400  이상 많 다. Table 2에  보

이는 것과 같이 일 인에게 가장 큰 향  주는 핵종인 131I  137Cs  출량

 각각 1,760 PBq, 85 PBq (1 PBq=1015  Bq) 도  추산 었다.  

 

Table 2.  Radioactivity released during the Chernobyl nuclear accident 

Core inventory Total emissions 

Nuclides Half-life 
Radioactivity 

(PBq) 

Emission rate 

(%) 

Radioactivity 

(PBq) 

133Xe 5.3d 6500 100 650 

131I 8.0d 3200 50-60 ~1760 

134Cs 2.0d 180 20-40 ~54 

137Cs 30.0d 280 20-40 ~85 

89Sr 52.0d 2300 4-6 ~115 

90Sr 28.0y 200 4-6 ~10 

132Te 78.0h 2700 25-60 ~1150 

140Ba 12.8d 4800 4-6 ~240 

99Mo 67.0h 4800 >3.5 >168 
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사고 주변 3개 지역이 137Cs 농도가 37 kBq/m2 이상  염지역  규

었다. 이들  경 500 km 내에 고 면 는 150,000 km2이며 500만 

명  인구가 거주 고 있었다. 사고 시 구역인 경 30 km 내  주민 

116,000명이 1개월 내에 소개 었고 원 마 인 Pripyat(인구  45,000명)는 

히 폐쇄 었다. 

 

2) 후쿠시마사고 

2011  3월 11일 후 2시 16분 동일본 해 에  동쪽  150 km 떨어

진 다에  리히  규모 9.0  지진이 생 고, 이어 10미 가 는 쓰나

미가 동북부 일본 해  강타 다. 이  인 여 후쿠시마 1 원  경  

4  원자  냉각용 가 작동 지  원자  내부에  어 불능  핵

합 이 일어나  시작 며, 소가스가 폭 여 원자  1, 3, 4

 건 이 손상  입었다. 이후 핵 생 이 외부  출  시작 여 원  

주변뿐만 니라 미국이나 럽  시 지 퍼 나갔다.   

Table 3  러시 에   자료이고, Table 4는 이탈리  라노에  

 자료들이다.  KINS에  실시  경 사능  결과를 보면, 134Cs과 137Cs 

핵종  국내에는 2011  3월 24일부  춘천에   시작했 며 4월 5일

부  국내  지역에  었다. 이  공 부 진  사능 농도를 살펴보면 

각각 0.024~0.144 mBq/m3, 0.024~0.196 mBq/m3 다. 주에 는 4월 6일부

 검출  시작했 며 각각 1.05 mBq/m3, 1.86 mBq/m3 이었다.   4월 6

일 18시부  내린 에 해 공  에 있  핵종들이 경  토양 에 입

었다. 다  Table 5, 6, 7  KINS에   자료들이고, Fig. 6   장소

를 나타내었다.   
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Table 3. Fission product radionuclides in environmental samples collected at Krasnoyarsk 

(Russia) between April 4 and May 3, 2011 

Sampling area 
Sampled 

material 
date 134Cs 137Cs 134Cs/137Cs 

Kranoyarsk-1 Melted snow 2011/4/4 0.095±0.002 0.075±0.03 1.28 

Kranoyarsk-2 Melted snow 2011/4/4 0.031±0.00 0.037±0.004 0.84 

Kranoyarsk-1 Melted snow 2011/4/6 0.026±0.002 0.024±0.007 1.08 

Kranoyarsk-2 Melted snow 2011/4/6 0.048±0.004 0.055±0.003 0.86 

Kranoyarsk-1 Rain water 2011/4/28 0.005±0.001 0.007±0.003 0.71 

Kranoyarsk-2 Rain water 2011/4/27 <MDA <MDA - 

Kranoyarsk-2 Rain water 2011/5/3 0.006±0.002 <MDA - 

Kranoyarsk-1 Pine needles 2011/10/20 0.740.11 1.03±0.20 0.72 

 

 

Table 4. 134Cs and 137Cs concentrations in soil at Milano, Italy, following the 

Fukushima accident 

Sampling area date 134Cs 137Cs 134Cs/137Cs 

Segrate 2011/3/3 0.83±0.30 12.26±0.70 0.068 

Senago uncovered 2011/4/4 0.29±0.13 85.17±4.40 0.003 

Senago covered 2011/4/4 0.47±0.28 84.65±4.40 0.006 

Segrate 2011/4/6 0.48±0.27 18.73±1.02 0.026 

Segrate 2011/4/13 <0.21 18.65±1.04 - 

Segrate 2011/4/20 <0.19 19.081.05 - 

Segrate 2011/5/4 0.45±0.19 9.62±0.56 0.047 

Segrate 2011/5/11 <0.06 11.99±0.63 - 

Segrate 2011/5/18 <0.07 24.95±1.30 - 
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Fig.6.  Map of regional monitoring stations and posts in Korea. 
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Table 5.  Ranges of 134Cs and 137Cs concentrations in daily aerosol samples collected at 12 

regional monitoring stations in Korea during March 28 to May 31, 2011 

Place 134Cs(mBq/m3) 137Cs(mBq/m3) 134Cs/137Cs 

주 0.04-0.54 0.04-0.55 0.87±0.03 

부산 0.04-1.19 0.04-1.25 0.96±0.02 

주 0.04-0.41 0.03-0.42 0.99±0.04 

구 0.04-0.25 0.06-0.27 1.00±0.04 

군산 0.06-0.36 0.08-0.45 1.00±0.03 

 0.04-0.14 0.06-0.13 1.01±0.04 

동 0.04-0.15 0.05-0.15 0.91±0.07 

청주 0.04-0.23 0.05-0.20 0.92±0.04 

원 0.04-0.23 0.05-0.22 0.88±0.04 

울 0.03-0.15 0.04-0.17 0.97±0.04 

강릉 0.05-0.20 0.04-0.26 0.81±0.03 

춘천 0.04-0.16 0.02-0.20 0.92±0.04 

 

 

Table 6. Ranges of 134Cs concentrations in daily rainfall samples collected at stations in Korea 

Inflow rate (Bq/m2) 

Place 

Mar Apr May Jun Jul Aug Sep Oct Nov Dec 

Total 
Inflow 

rate 
(Bq/m2) 

 

울 0.00 - 0.13 0.09 0.04 - - - - - 2.21 

강원 - 2.69 0.21 0.05 - - - - - - 2.95 

충남 - 0.33 0.15 - - - - - - - 2.48 

충북 - 0.55 0.17 0.05 - - - - - - 0.77 

북 - 3.46 0.08 0.02 - - - - - - 3.56 

남 - 2.44 0.43 0.18 0.45 0.10 0.20 - - - 3.81 

경북 - 1.27 0.11 0.04 0.14 0.05 - - - - 1.60 

부산 - 4.81 3.19 0.44 0.49 0.39 - 0.03 0.03 0.05 9.43 

주 - 24.52 0.37 0.20 0.07 0.09 - - - - 25.2 

국 0.00 2.44 0.56 0.10 0.14 0.07 0.03 0.00 0.00 0.01 3.35 
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Table 7.  Ranges of 137Cs concentrations in daily rainfall samples collected at stations in 

Korea 

Inflow rate (Bq/m2) 

Place 

Mar Apr May Jun Jul Aug Sep Oct Nov Dec 

Total 
Inflow 

rate 
(Bq/m2) 

 

울 0.01 2.36 
.36 

0.17 0.13 0.07 - - - - - 2.74 

강원 - 0.38 0.29 0.06 - 0.03 0.03 - - - 3.79 

충남 - 2.86 0.19 0.05 - - - - - - 3.10 

충북 - 0.72 0.21 0.09 - - - - - - 1.02 

북 - 4.19 0.10 - - - - - - - 4.29 

남 - 2.92 0.52 0.27 0.57 0.14 0.17 - - - 4.59 

경북 - 0.87 0.32 - - - - - - - 1.19 

부산 - 10.64 3.96 0.53 0.58 0.51 0.07 0.04 0.03 0.07 116.4 

주 - 28.69 0.44 0.28 0.08 0.11 - 0.02 - - 29.6 

국 0.00 2.44 0.56 0.10 0.14 0.07 0.03 0.00 0.00 0.01 4.69 
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2. 사  핵종  거동 

 

사  핵종들  생원 부  출 여 권에 산  후 강 에 포착 

거나, 사  강 (fallout)  장 간에 걸쳐 지 면에 강 어 경 에 

분포 다.  

 

2.1 사능  산 

 에  우주 에 해 생 거나 는 핵실험에 해 생  사능  

지구 규모  산 어 침 므  지구상  남극이나 북극 는 심해에 이르

지 분포 다. 라  이 게 산  사  핵종  경  그라운드

(background level)를 고 있다. 사능  산에 요  권  지상 

평균 높이 11 km 지이며 고도에 른 도감소 이 6.5℃/km 도이다. 부

분  상 상이 일어나는 1~2 km 지를 행 경계 이라 다. 권  

권상 부 고도 약 11 km에  50 km에 이르는 지역이다. 권에 는 고도에 

라 도가 상승 며 가 고 상 운동이 없 므  사능이 입 면 

간 남  있게 다. 권  높이는 도  계 에 라 9 km에  17 km

지 변 다. 권  공   고리를 Hadley cell이라 는데 이는 계 별 

는 도별  변동 다. 이에 권 상부  권 부 사이에   산이 

일어나면  권 사능이 권  여 들어  지상에 침착 게 다. 이 

상  철에 가장 다. 이것이 철에 낙진 강  량  많이 찰   있

는 이 이다.   

원자 시 에  상 운 시 체 사능이 굴뚝이나 지 에  출 면 주변 

가 운 지역  산 며 침  범 는 십 km 도 내  다. 이  출
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는 사 질  산이나 폭 량 평가를 해 취 는 상  원자  

상이라 다. 굴뚝  원에  풍  향  산 어 가는 plume이 

Gaussian 분포 태를 보인다고 가 면 이  지상에 (Z=0)에  사능농도는 

래  같이 다.  

 

 

X(x, y) = Q/(πσyσz U) ᆞexp[-(y2 /2σy
2 + h2/2σz

2)]          (1) 

 

 

 식  Gaussian plume 모델이라 다. Q는 출  U는 평균 풍속이며 σy σz  

산계 써 풍속과 pasquill  도 계 부  계산 다.  식  가장 

간단  태  식이므  실  용 시에는 지 효과 미 상상태 등  보 여 

사용 게 다. 일  원자  시 에 는 Gaussian 산모델   작

 산 드(ODCM: Off-site Dose Calculation Manual)를 사용 여 주민

량  평가 다.  
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2.2 사능 질  침  

핵 실험이나 원자 시 부    출  사 질  를 타고 

산 어 침 거나, 강  함께 지 에 침 여 권에  거 다. 사

능이 강우에 해 침 는 것  습침 (wet deposition)이라 고 건조   상

태  침  건침 (dry deposition)이라 다.  

사능  침 속도는 습침  속도  건침  속도를 합  값이다. 침 속도는 

사능  리  태  후조건에 향  는다. 지상  떨어지는 사능

 식 체 면에 착 다. 식 체 면  사능  어 가식부  겨지

고 식품 취  함께 인체에 들어 게 다. 지상  떨어지는  낙 량 에  

식 체 면에 침 는 분  차단계 (interception factor)라 다. 이 차단계

는 식품 취 경 에  사능  취량 평가에 요  인자이며, 건ᆞ습침  

태  사능  리  특   식생 도에 함 이다. 식생 도를 고  

차단계 는 Chamberlain  식이 리 사용 다. 

 

R = 1- exp(-μ Yt )                         (2) 

 

 식에  차단계  R   시 지상부  식생 도 Yt  함  나타냈다. 여

 상  μ는 경특 에 라 2.3~3.3 사이  값  쓴다.  

 지  는 식 체 에 침  사능  재부 (resuspension)   있다. 재부  

질  낙진에 추가 어   농도를 증가시키는 효과가 있다. 지상 핵실험이 

단  후 낙진량  히 감소 여 거  검출 에 다다르고 있다. 재 

 침  검출 는 137Cs, 239Pu, 240Pu  주 생원  나는 침  사능  

재부 라고 간주 고 있다.  

 



 

31 

 

2.3 상에  거동 

지상에  침  사능  토양 내에  이동, 토양에  농작  이행, 토양에

  이동 등  이동경  명   있다. 이러  상 이동경 는 

경감시계획  립   주요 고 사항이 다. 토양입자에 강 게 결합 는 

핵종  이동속도가 늦다. 137Cs, 239Pu, 240Pu  토양입자에 강 게 결합 는 것  

다. 몇 가지 핵종  토양 내 존재 태는 Table 8에 보여주고 있다. 

 

 

Table  8.  Fraction of radionuclide added to the soil (%) 

Nuclides soluble exchangeable fixed 

90Sr 5~10 80~90 2~15 

137Cs <0.2 30~40 50~70 

106Ru 5~15 3~5 80~90 

91Y 0.5~1.5 2~5 >95 

144Ce 0.1~0.5 1~5 >95 

 

 

토양에 존재 는 핵종  식 체  다. 이를 이라 며 토양에  식 체

 겨가는 도를 이계 (transfer factor)라 다. 핵종  이계 는 10-1~10-2

도 이다. 회(Ca), 칼리(K) 료는 토양  경쟁이  효과가 있 므  90Sr

 137Cs   떨어 릴  있다. 

 

 

 

 



 

32 

 

2.4 경감시 주요 상 핵종 

경에  주 심 상 핵종  핵실험 낙진과 원자  시  출    

감 가  것들이다. 각 경매질에  주요  핵종  래 Table 9에  명

다. 

이 에  감 가 짧  것들  재 운  인 원자 시  부근에  검출  

 있다.  

 

Table 9.  Radionuclides that are detected in the environment 

Major Radionuclide 137Cs, 90Sr, 3H, 14C 

Air 131I, 134Cs, 137Cs, 3H 

Water 3H, 89Sr, 90Sr, 131I, 134Cs, 137Cs 

Soil 90Sr, 134Cs, 137Cs, 238Pu, 241Am, 242Am, 99Tc, 129I 

Milk 89Sr, 90Sr, 131I, 134Cs, 137Cs 

Vegetation 89Sr, 90Sr, 95Zr, 131I, 134Cs, 137Cs,  

 

 

원자 시  출 리가 철 므  경에 심이 만  사능  출이 

거  없다. 시 에  리 떨어진 지역  경에  주요 검출 상  137Cs, 90Sr, 

3H, 14C 등 4종이며 Pu 동 원소도 드시 검출 다. 이들  핵실험 낙진이 지구

규모  산 침  결과이다. 편 재처리 시 이나 폐  처분장에 는 Pu 동

원소, 241Am 등 우라늄(transuranic)원소  장 감  핵종인 99Tc, 129I이 주요 감

시핵종에 추가 어야 다. 주요 핵종  경 베이스라인 는 137Cs  ~80 

Bq/kg in dry soil , 90Sr  ~15 Bq/kg in dry soil이다.  137Cs  분포는 핵실험 낙진과 체

르노  사고에  것  토양 입자에 강 게 결합 여 이동 이 므  지
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에 10 cm 이 이내에 부분 분포 고 있다. 재 국내 경 는 80 Bq/kg 

in dry soil 이나 이 많이 축   속에 는 4  이상 검출 다. 이

별 분포를 Fig. 7에  보면 137Cs  이동이 느  지 에 많이 분포 고 이에 

여 90Sr    곳 지 이동  보여주고 있다.  

 

 

Fig. 7. The distribution of radioactivity in soil per depth (Prior to 1994 Halla 

Mountain). 
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3. 감마 과 HPGe 검출  상 작용  

사  검출  동작  해야  사 과 검출  자체  검출매질이 어떤 

리  상 작용  는가에 존 다. 사 이 그 질과 어떻게 상 작

용  며 에 지를 잃어 가는 본 인 과  충분히 해야 다. 그  감

마  는 법  질과 검출  상 작용  생  고속 자를 검출

는 간 인 법이 이용 고 있다. 원자핵에  출 는 감마  에 지는 

보통 0.1~10 MeV 사이  값이다. 이 에 지 역에  일어나는 작용  많지만 주

 효과(photoelectric effect), 컴 산란(compton scattering)  자 생

(electron pair production)  상 작용이 일어난다.  

 

3.1  효과 (photoelectric effect) 

에 지 E0인 감마 이 원자  궤도 자에 어 에 지를 달함 써 궤

도 자가 이탈 여 자  출 는 상이다. 라  자(X 이나 감마 )

는 소멸 고 그 에 지를 자가 가지게 다. 궤도 자는 일  크  결합에

지(Eb)를 가지므  자는 에 지 Ee= (E0-Eb) keV를 갖는다. 자는 부

분 K-각 자가  나가면  만들어지게 므  K-각 궤도 자  자리

는 다른 궤도  높  에 지를 가진 자가 에 지를 출 면  채워지게 다. 

이 과 에  특  X 이 나 거나 다른 궤도  자  상  작용 여 Auger

자가 나 게 다. 이 X 들  거  생  주변에  므 , 결국  E0 

체가 검출  내에 자 에 지 태  는 이 다. 그 결과  검출 신

는 E0에 는 특  크  펄스들  낸다. 이 펄스들  고분  계

면 특  채 부근에 많  계 가 찰 어 이를 도시 면 크가 다. 

이 크를 에 지 크 는 크라고 부른다.  
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3.2  컴  산란 (compton scattering) 

입사  감마 이 자 자나 결합 이 매우 약  궤도 자  충돌  입사 

감마  에 지(hv)  일부를 자에게 주어 자를 원자  튀어나가게 

고 입사  감마  에 지가 감소 어 산란감마 (hv´)  나타난다. 이  

입사 감마  에 지를  원자  튀어나  자를 컴  자라 다.  

에 지가  keV 이상인 감마  경우에는 다  상 작용에 해 산란감마

이 검출 내에  효과를 일 키게 며  peak를 만드는 역  고 

있다. 그러나 검출  주 는 차폐체  차폐시  사용 므  원 부  나  

감마 이 다시 차폐 질에 해 컴  산란이 일어나게 다. 이 산란  감마

이 다시 검출  입사 게 면 후 산란  peak가 나타나게 다. 에 지  

운동량보존법  연립 여 풀어  산란각과 감마 자  에 지  컴 자

 에 지 사이  계는 다 과 같다. 

 

Ec = Eγ-  

=  Eγ-                    (4) 

 

여  α는 Eγ/mec
2 이고, Eγ는 입사감마  에 지이며, θ는 입사감마  

향과 산란 감마  향이 이루는 각이다. 감마  산란각에 라 컴  자
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는 소 0에   2αEγ/(1+2α) 지 연속 인 에 지 분포를 가진다. 

 

 

 

3.3 자 생  (electron pair production) 

자 생  입사감마 이 검출  매질인 Ge  원자핵 근처를 지날  강

 Coulomb장  인해 입사감마 이 소멸 고 신 자  양 자  이 생

는 과 이다. 입사감마 이 자  양 자를 생  해 는 에 지 보존

법 에 라 자  지질량 에 지  2 인 1.02 MeV 이상  에 지를 요

 다. 이  운동량이 보존  에 원자핵도 튐 지만 원자핵  질량이 

자  질량보다 훨  크  에 그 운동에 지는 매우 작 며, 시   있

다. 양 자가 검출  매질  통과 면  자신이 가지고 있는 모든 에 지를 잃게 

면 인  자 자  결합 여 소멸 고, 0.511 MeV  에 지를 갖는 2개  

감마  생시킨다. 이 게 생  감마  양 자 소멸 사 (annihilation 

radiation)이라 다. 스펙트럼 상에는 2개  소멸 자가 상 작용  지 고 

검출  외부  이탈 게 면 double escape  나타나고, 1개  소멸 자가 

효과를 일 키고 다른 1개는 검출  외부  이탈 게 면 single escape가 

며, 2개  소멸 자 모 가 검출 내에  효과를 일 키게 면  에 지 

가 다.  검출 내에  1개  2개  소멸 자가 컴  산란  일

키는 경우에는 연속분포  나타난다. 감마  에 지가 주 큰 경우 생

에  단면  다  식과 같다.  

                     (5) 
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 자  생 는데 요구 는 소  에 지는 1.022 MeV 이므  에 지

가 1.022 MeV 이상  감마 에 는 요  가진다.  원자번  곱에 

므  같  에 지인 경우 원자번 가 높  질에  많이 가짐   

 있다.  

 

III. HPGe검출 를 이용  감마분  분 법 

 

1. 원리  구  

 

감마  검출 는데 히 사용 는 검출 는 체충  검출 ,  검출 , 

도체 검출  등이 있다. 사  검출 에 역  인가 면 캐리어(Carrier)

가 거  공 (Depletion layer)이 생 는데 이 공 이 사 에  감

지  역  다. 공 에   생과 집에 여 입사 감마

이 공  내에  리작용  가 (Valence band)에  도 (Conduction 

band)  자가 이 고 동시에 가 자 에는 양공(Hole)이 생 다. 자-양

공 1  만드는데 요  에 지는 게르마늄(Ge) 도체인 경우 2.96 eV이고 

체는 30 eV이다. 체 리함  일 인 리 에 지에 해 매우 낮  리

에 지를 가진 Ge 도체는 높   생이 가능 고 통계  우  분해

능  가진다. 이 연구에 는 리퍼 이 낮  도체 검출 를 이용 다. 

도체 검출 에는 Ge(Li)검출  HPGe검출 가 있지만 이 실험에 는 불

 농도가 높  높  bias  걸어   있 며, 상 에 었다가  

에만 체질소  냉각시  사용   있는 ORTEC사  HPGe검출 를 사용

다. 검출  직경  58.5 mm 이고 이는 52.7 mm이며 60Co  1332.5 
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keV 감마 부  3˝x3˝ NaI(Tl) 검출 에  상 효  30%, 분해능

 1.85 keV, 그리고 peak-to-compton 는 60이다.  핵종분 용 스펙트럼  

MCA(multichannel analyzer) Card  며, 스펙트럼 분  APTEC 

그램  이용 다.  Fig. 8과 10  검출  신 처리  스펙트럼 집 

름도를 나타낸다.  요  장 는 본  HPGe검출 , 증폭 (Pre 

amp), 주증폭 (Main Amp), ADC(Analog-to-Digital Converter), 다 고분

(MCA), 고 공 장 (HV Supply)이다. 검출 는 개 증폭 (Pre 

amp)  같이 일체  결합 어 있다. 주증폭 , ADC, 고 공 장 , MCA

는 일  NIM(Nuclear Instrumentation Modules)  이용 다. 이들  

어  나  모듈  작  것도 있 며, 이것  USB  PC에 연결 여 사용

다. 이 경우 PC에  MAESTRO, Gamma Vision, APTEC 등과 같  감마

 분  그램(Emulator)이 MCA 역  행 며 에 지 분  결과는 

PC  모니  상에 시 다. 검출 는 외부 사  향   여 

납 차폐용 에 어야 다. HPGe 검출 는 극  냉각해야만  능  

므  검출 에 연결  구리 냉각  체질소가 들어 있는 용 (LN 

Dewar)에 삽입 여 사용   소  2시간 동  충분히 냉각(77K)  시

야 다. 검출 에 연결  이  고  이 (HV cable), 출 신  이 , 

증폭  원 이  3개  이루어  있다. HPGe 검출 는 개 약 4000 V 

도  인가  요  므  고  이 (HV cable)  NIM  고  

공  모듈에 연결 고, 신  이  주 증폭  모듈에 연결 고 증폭  

원 이  주 증폭  모듈  뒷면에 있는 해당 단자에 연결 다. 각 이  

끝 모양이 다르  에 동  일 킬 염 가 없다. 주 증폭 는 증폭 에

 출 는 미약  pulse신 를  증폭 며, 증폭  pulse신  높
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이는 감마  에 지를 나타낸다. ADC는 주 증폭  모듈에  출 는 pulse

를 높이에 라  변 는 역  다.  pulse는 다 고분

(MCA)에 입 어 각 에 해당 는 모리에 장 다. 감마  분  

그램에는 개 핵종 Library가 포함 어 있어 각 에 지 크에 해당 는 핵종

 Library에  찾  에 지 스펙트럼에 시 다. 

 

 

Fig. 8. Flow chart of a signal processing and collection about HPGe detector. 

 



 

40 

 

 

Fig. 9. High purity germanium(HPGe) γ-ray spectroscopy system. 

 

Fig. 10. High purity germanium(HPGe) γ-ray spectroscopy system mimetic 

diagram. 
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2. 시료 조   효  법 

 

2.1 시료( 원) 

경시료  감마 사능 분 에  감마  에 지는 약 50 keV에  3 MeV 도

 감마 핵종  분 상  다. 라 , 시료는 100 keV에  2 MeV 사이

에 감마  출 는 109Cs, 57Co, 139Ce, 203Hg, 115Sn, 85Sr, 137Cs, 88Y, 60Co 감마 핵종이 

합 어 있는 감마 용  용 원 QCY44 (Amersham Co.)  사용 다. 

본 실험에 는 Table 10과 같이 원  사용 여 에 지   peak 효

 행 다. 

 

Table 10.  Standard source (QCY44, Amersham) used for analysis of HPGe detector 

Nuclide Energy (keV) Yield Half-life (day) 
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109Cd 88.03 0.0363 462.6 

57Co 122.06 0.8560 271.79 

139Ce 165.86 0.7987 137.64 

203Hg 279.2 0.8148 46.595 

115Sn 391.7 0.6489 115.09 

85Sr 514.01 0.9840 64.849 

137Cs 661.66 0.8510 11012.7 

88Y 898.04 0.9400 106.63 

60Co 1173.24 0.9986 1924.2 

60Co 1332.5 0.9998 1924.2 

88Y 1836.06 0.9936 106.3 

 

 

 

 

2.2 시료 조  

시료 조 는 감마 출 핵종이 합   용 원 QCY44를 1 M HCl 

용  당히 희  후, 이를 시료용 (diameter 50 mm, height 70 mm; Mizuho 

Chemical Co., Japan)에 게를 달고 사능 농도를 계산 다. 경시료  경우 

높이를 일 게 채우 가 곤란  에 효   에 지 용 시료는 약 5 

mm 간격  높이별  1 M HCl 용  2.5 mm에  50 mm 지 11개   용

원  조 다. 시료자체 (self-absorption effect)에  향에 해 

도 보   여 각각  게를 히 량 다. 

 

2.3 효  

조  시료는 Table 10과 같  특  가지는 HPGe검출 (GEM-30185, 

EG&G Ortec, USA)  MCA(Model 92X, EG&G Ortec, USA)  구  감마분 계
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에  각각 80,000  동  행 다. 계  스펙트럼  효 과 에 지 식 

 분해능  갖도  Aptec program(Aptec Co.)  감마  에 지  높이에  

내삽 인 계식  구 여 2.5 mm에  50 mm 지 1 mm 간격  효 과 에 지 

 분해능  갖는  spectrum  만들었다.  용 원 에 포함 어 있는 

60Co  88Y 핵종  각각 1173.24 keV  1332.5 keV 그리고 898.04 keV  1836.06 

keV  감마  출 는 동시에  다른 감마  2505.74 keV  273401 keV  

출 는 동시합산효과(summing effect)를 나타내  에 계 효 이 감소 다. 

 시료  도는 시료  질과 감마 이 상 작용  일  시료  자체

효과(self-absorption effect)를 나타내  에 원과 시료  겉보  도가 

다를 경우 계 효 이 감소 는 경향이 있다. 라 , 동시합산효과(summing 

effect)  시료  자체 효과(self-absorption effect)를 보 다.  

3.  스펙트럼 Data  해  

 

감마  스펙트럼 data해  법  목 이나 요  는 보  종 , 스펙트

럼  특 ( 크  분해능과 모양, 크  존재 도, 통계  요동 등)  해 단

(계산  종 나 능 )등에 라  여러 가지 법이 있  에 일  

명 는 곤란 다. 
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Fig. 11. Flow chart of Data analysis. 

 

 

특히 해 단에 존 는 도가 크고 스펙트럼 해  신속 ,   신

뢰  요구 는 경우 컴퓨  사용  연 이라   있다. 즉 4000개 도  

 data(채 당 counts)를 처리 는 일에 있어  MCA  모리 부  컴퓨

 data 송  시작  각종 연산 부  해 결과를  지를 일

게 행 는 data처리가 불가 다. 라  늘날 PC  컴퓨 를 통해 일

게 data처리를   있는 상용  S/W들이 많이 보  어 있다. Fig 11  감마
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 스펙트럼 해 에 있어  일 인 data 해  름도이다. 이 름도는 사용

나 해 단에 라 상당  차이가 있   있다.  

 

3.1 스펙트럼 평   크 검색( 별) 

 Ge검출   감마  스펙트럼  경우 일  크 부분  평탄  

연속부(이  baseline이라 함) 에 있 며 통계  요동이 해  있다. 이것  

신  다면 신 분( 크), DC 분(baseline)  잡 분(통계  요동)

에 해당 다. 라  신  잡   (S/N )를 개 고 DC 분  거 여 

신 분  분 는 것이 감마  스펙트럼 해  목 이다. 그  1단계가 S/N

 개 , 즉 스펙트럼 평 이다. 신 는 filter회 에 해  능동  

  있지만, 이산 인 data인 감마  스펙트럼  평 는  filter를 이용  

연산처리를 통해 행 여야 다. 이  같이 통계  요동이 포함  자료를 만

게 는 통계  잡  거 는 법  가장 간단 게는 어떤 특  채

 포함  좌우  구간내에  평균값  구 는 법이다. 이  각 들이 동등

게 평균값에 여 는 평균  단 이동평균이라 고 이것  단 히 산 인 

평균  미 는 것이다.  

평  처리는 2번 이상  는 것이 좋 며, 주  것  크  해 역  

그 도에 맞도   해야 다는 과 그 근 에 크가 있  에는 

크 심이 shift 게 다는 이다. 

다  크검색에 해  명 고자 다. 스펙트럼에  크를 컴퓨  

별 는 법  어떤 별   해 고 이것과 해   도에 

라  결 는 법이다. 평 는 S/N  개  목  일종  분 조작

(convolution)  는 것이고 크  검색 법   스펙트럼 미분  염 에 
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 법  본  고 있다. 스펙트럼  baseline  어떤  채 역(

폭  도)에  거  직 에 가 다고 생각   있  에 1차미분 는 

2차미분  함 써 크가 거 는 것이 있다. 그러나 통계  요동이 큰 스펙

트럼  그  미분 면 요동이 욱  커지므  평 를 포함  법이 이용

고 있다. 그 법  이차미분 법  들  있 며 에  명  평  

거  동일  법이다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2 크 심 채  결  

 크 심 채  구 는 법에는 여러 가지 법이 있는데, 크 폭, 크 

칭 , 계  통계  요동  계산 단 등  고 여 당  법  택 다. 

그래 상에 plot  그림 부  략 인 심    있지만 감각  요구를 

는 미에  여 에 는 계산에  법  명 고자 다. 
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○1  1차 미분계  Zero-Cross법 

 이 법  에  명  스펙트럼 평 나 크 검색법  단과 슷  

것  크  1차 미분계 가 zero를 가  지나는  크 심  는 

법이다. 

○2  지 함  변 는 법 

 크  심부분  Gauss함  근사  가 있 므  이를 단  지 함  

변 함 써 크  심채  구 는 법이다. 이 외에도 크  게 심  

이용 는 법, 크 근  3  계 에  법 등이 있다. 

 

3.3 폭(FWHM)  결  

HPGe 검출  얻어진 감마  스펙트럼  보통 0.5 keV/ch 도  채 폭  이

용 는데 이  같  경우에 크를 는 채  는 껏해야  채  도

이다. 라  크 부분  data를 plot해  FWHM  구 는 것  매우 어 다. 그

러므  크  심부분  Gauss함  가 해  계산  구 는 법이 이용

고 있다. 이러  법 는 함  fitting법(  소자승법)  지 함  변

는 법 등이 용 고 있다.  

 

 

3.4 크 면 (Area)  결   

크 면  크  (net)계  합 써 이것  가지고 사능  량

 결 다. NaI 검출 부  얻어진 스펙트럼  경우는 에 지 분해능이 상

 좋지  에 baseline  이 곤란 여  크  면  구

가 쉽지 다. 이에 해  Ge검출 부  얻어진 감마  스펙트럼  경우

는 Baseline이  명 게  가 있  에 크 면  구 는 것
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이  용이 다.  

크 면  구 는 법 는 크게 구분 면 채 들  계 를 합산 는 

계 산법과 함  fitting법  나   있다. 자는 독립 인 크에 해

는 계산이 쉽  에 신뢰 이 높지만 2개 이상  크가 근 여 있거나 

첩 면 해 이 곤란 다. 후자는 독립 인 크에  보다는 히  첩  크

 해 에 합 지만 컴퓨 를 요  고 계산시간이 며(컴퓨 능, 라

미   등에 계 ), 해  그램  만들 가 쉽지 다.  

 

○1  해 역   

 계 산법, 함  fitting법  불 고 크 면  구 는 것에는 해 상 

모  채  역( 크 역과 baseline 역)  결 지 면  다. 즉 함  

fitting법에 는 크 역과 baseline 역  나 어 다를 포함  해 역  결

다.  

  

○2  계 산법에  크면  결  

 계 산법에  크면  구 는 법  계산이 간단  에 

리 이용 고 있 나 주  독립 인 단일  크에 해  효 다. 그러나 첩

크에 해 도 특별  경우( 크가 동일 핵종에  것, 는 다른 독립 인 

크가  크인 것)에 용   있다. 실  감마  스펙트 트리에 있

어  부분  경우에 이 법 도 충분 데 특히 경시료  감마  분 과 

같  특  핵종만  상  는 경우에는 히  이 법이 가장 당 다. 

계 산법에 있어  크 태는 직  계없지만 히  baseline  

태가 가 는 경우가 많다. 그러나 해 역이 그다지 지  에는 

baseline  직  취해도 거  가 없다.  크가 공 롭게도 컴  edge
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에 걸 있는 경우에는 직  baseline  차가 크게 지만 이  같  경우는 

거  희 다. Baseline   명  baseline 역  계  구 는데 일

 에 지쪽과 고에 지쪽  계 가 계단  어 있어  이를 직  

처리 거나 는 2차식, 3차식 등  다항식  용 여 처리 는 법이 있다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. 경 스펙트럼   보  

 

검출 를 납 차폐용 에 고 시료 없이 에 지 스펙트럼   경우에도 

다양  에 지 크가 나타난다. 이러  경스펙트럼  검출  주변  자연 

사  핵종, 검출  는 차폐체에 들어있는 사  핵종, 계  계통  잡  등에 

인 다. 이러  경 스펙트럼  시료를 는 경우 첩 어  나타나므  
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미리 여  시료를  스펙트럼에  빼주어야 다. 주   시료

 경  는 시간  같게 여야 며, 같   구조  특징

 가지는 시료용 를 시료를 충진 지  상태에  계 에 고 다. 

개  감마  분  그램에는 경 스펙트럼   데이 를 장해 고

 보 는 능이 있 므  이것  이용 면 다. 경스펙트럼  보 는 

법  인 면에  Analyze->Setup-> Background subtract (Shift+B)에 들어가  

이 에 장해 었  경 스펙트럼  불러 고, 크 탐색 후 Analyze-> 

Background subtract (B)를 택 면 다. 

 

 

 

 

 

 

 

 

 

 

 

5. 소검출 사능(MDA)   

 

사  계 시스  자연 사  경 속에  운용 므  연  

background  향  는다. 그런데 시료  사능이 극히 미미  는 그 신

를 background  구분  어 워지므    있는 사능  계 가 

생 다. 실  얻  계 가 background  구분   있는 계를 검출 계
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(Low Limit of Detection: LLD)라 부르고 이 부  계 효  등  여 사능

 산  값  소검출 사능(Minimum Detectable Activity: MDA)이라 부른다. 

                       

(6) 

 

여  y는 붕  당 사  출 , ε  계 효 , ts는 시료계 시간이다. 여

 보듯이 어떤 계  시스  해 낼  있는 시료  소 사능  

계  그라운드 계 가 작고 계 효 이 크며 계 시간이 어질  작

진다.  

 

 

 

 

 

 

 

 

 

IV. 실험 재료  법 

 

1. 채취지  

본 연구에 사용  토양  이끼 시료는 주도 역에 걸쳐 미 경작지 12개 
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지  고, 채취지  주변에 장해 이 없고 지면이 노출 어 있 며 

침식, 붕 , 인  란  식생 등  향이  평탄  곳  다(Fig 

12, Table 11).  

 

 

Fig. 12. Distribution of the sampling locations in Jeju Island. 

 

 

 

 

 

Table 11. Geographical information of the sampling locations 

Location Geocode 
Altitude 

(m) 
Sampled date 

S1 
33 25.285 N 

126 33.248E 
569 2011-11-01 

S2 
33 25.384 N 

126 37.464 E 
605 2011-11-01 

S3 33 25.384 N  354 2011-11-11 
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126 37.464 E 

S4 
33 25.146N 

126 46.561E 
205 2011-11-01 

S5 
33 27.011 N 

126 46.027E 
251 2011-11-01 

S6 
33 17.980 N 

126 35.147 E 
245 2011-11-01 

S7 
33 19.265 N 

126 17.126 E 
166 2011-11-15 

S8 
33 26.121 N 

126 41.325 E 
407 2011-11-15 

S9 
33 27.385 N 

126 24.387 E 
122 2011-11-15 

S10 
33 15.792 N 

126 19.699 E 
116 2011-11-15 

S11 
33 23.457 N 

126 41.213 E 
423 2011-11-15 

S12 
33 22.226 N 

126 28.311 E 
1076 2011-11-15 

 

 

 

 

 

 

2. 채취 법 

토양 시료는 일  면 (50x50 cm)  지 면  지  후 분해 지  

(나 가지, 낙엽 등)  모  거 여 1 cm 이 이내  토를 모삽  약 

2 kg 도 채취 다. 사 조사 결과 토심  5 cm 지 채취 는 일 인 토양 

채취법  채취  경우, 134Cs 사능 농도는 주 극미량  검출  이

 었  에  토만  채취 는 식  택 다. 이끼 시
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료는 토양  채취  지 부  10 m 이내에  돌 이나  에 자생 는 

것  채취 고, 채취  이끼에 붙어있는 토양   분리 여 분  시료  사

용 다. 그리고 토양 이에 른 사능 농도 분포를   토양 시

료는 2개 지   후 25 cm 이 지 채취   있는 8개  크릴 재질

 원통  (직경 5 cm, 이 25 cm) 채취 를 작 여 채취 다. 그리고 채취

 시료는 잘  다  연구실  겨  토심 5 cm 지는 1 cm 단 , 5 cm 

이후부 는 2.5 cm 단  분리 여 분  시료  사용 다. 

 

Fig. 13.  Sampling of environment soil and mosses. 

 

3. 처리 법 

○1  시료는 신 지 등에 펼쳐 놓고  돌덩이, 나 잎 등  이 질  거 고 

골고루  다  tray 에 고 건조  량(FW: fresh weight)  다. 
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Fig. 14.  Drying and weighing of samples. 

 

 

② 쳐 있는 토양 시료 덩어리 들  잘 부 어 주고, 105℃  열풍건조 (dry 

oven)에  약 24~48 시간 이상 건조시킨 후 상 에  식히고 건조 량(DW: dry 

weight)  다. 여 , FW DW 를 는 이 는 시료  분함량  

구 여 토양  inventory  계산   것이다. 

 

③ 건조  시료는 2 mm mesh  체 고 이  통과  시료를 건조 토라 부르고 

이를 분  시료  다. 이  2 mm mesh  는 이 는 토양  2 

mm 를 통과  것만  토양   이다. 

 

 

Fig. 15.  Separation of soil using a 2mm mesh. 

④ 2 mm mesh 를 통과  건조 토는 균일  시료를 얻어  보  

해  분쇄 에 고 잘게 부  후  tray 나 종이 에 가능   평평 게 

펼쳐놓 다. 그리고 우 자 모양  9 등분 여 각 부분에  일 량  취  

다  합 여 감마핵종 분  시료  다.  
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Fig. 16.  Pulverized soil were put into a U8 container. 

 

 

⑤ 감마핵종분  해 합  토양시료는 U8 용 에 고 덮개를 닫  

고 시료 게  시료 높이를  후 용  뚜껑에 다. 여  

게  높이를 는 이 는 이 과  통 여 시료  도(g/cm3)를 구 여 

면 종 사능 계산시 단  산이 가능  이다. (Bq/g ⇆ Bq/cm3)  

 

 

 

Fig. 17.  U8 container containing a soil sample. 

 

 

⑥ U8 용 에 고  시료는 HPGe 검출  에 얹어 놓고 감마  분  

실시 다. 검출 가 염   있 므  검출 를 얇  라스틱 wrap  

감싸주었고, 계  시간  80,000 (22 시간)동  다.  
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Fig. 18.  Is measured using a HPGe (Measuring time: 80,000 sec). 

 

 

이끼 시료  처리 경우도 토양 시료  사 지만 채취 직후 이끼에 붙어

있는 토양들  분리 고, 남 있는 토양  히 거  여  척

며 이를 이끼 토양 시료  구분 여 추가  사능 분  행 다.  

 

 

 

 

 

 

 

 

4. 감마분 분 법에  핵종 분  차 

 

감마분 분 법에  핵종 분  우 , 차가 다 운 분리 등  

요  지 며,  분 고자 는 시료를 곧  계  가 있고, 시료 

내에 있는 사 핵종들  인 식별과 동시에 량이 가능 다. 그 외에 
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부분  핵분열생  감마 이 출 고 있  에 감마분 분 법  원자

 계시 부  출 는 각종 사 핵종  사능 감시  주요  단

 사용 고 있다. 라 , 감마분 분 법  경 사능 분야에  품질

리 단이 고 있다.  

감마분 분 법  시스  는 과 과 고자 는 시료를 채취

 다  처리를 거쳐  후 분 는 2가지 과  나   있다.   

경시료에  감마  스펙트럼  분  계 가 낮 며, peak  모양이 찌

그러지고 해 peak  인해 분 가 매우 어 다. 라  종단계에  분

자  경험 인 인 차가 드시 요 다.  

분 용 시료는 시료  집과 부  처리과  거쳐 조  시료

지  각종 자료를 자 히 해 었고, HPGe 검출   감마 사  스

펙트럼  사  핵종 분 에 리 이용 고 있는 APTEC 그램  사용

다. 그리고 핵종 별에 이용  library는 EML(Environmental Measurements 

Laboratory, USA)사에  작  EML300. Lib를 용 다. 경시료에  

감마 핵종  분 에  과  Fig. 19  같다. 
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Fig. 19.  Flow chart about γ-ray spectrometry method. 
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5. 감마핵종 분  법 

 

본 과 에  스펙트럼 분 Aptec 그램  이용 다. 인 

면에 Sample Description (F5) -> Quantity Description (F6) 작업  

료 고, Analyze-> Setup -> ROI properties, Peak search, Multi fit, 

Identification 작업  진행 다. 그리고 Edit -> Load Header 

Information  택 후 이 에 만들어 었  일  불러 다. 를 들어 

U8 용 에 충진  경시료  높이가 35 mm 라면 높이 별  장해   

일에  35 mm 에 해당 는 일  찾  열 를 른다. 그러면 Header 

Information 창이 열린다. 일  Effiency & Resolution Calibration 

보만 택 여 sample 시료에 용 다. 이는 사능 농도를 계산   

효  용   것이다. 그리고 Analyze-> Setup -> Background 

subtract (Shift+B)에 들어가  분 이 료  Background 일  택 다. 

그 다  Analyze-> Setup -> Quantify (Shift+Q)  택 여 단 를 

택 여 주고, Activity Calculated 에  사능 농도 일  해 다. 

일  시료 채취일  입 해 다. 를 마 고 크탐색 -> 에 지 

 다. 부분  Spectrum  232Th(63.3 keV), 226Ra(186.1 keV), 

212Pb(238.6 keV), Ann peak(511 keV), 40K(1460.8 keV), 208Tl(2614.4 

keV)  같  핵종들이 검출  에 이들  이용 여 에 지  행 

가능 다. 다  핵종 별 과 에  검색  크에 특  핵종 작명 거나,  

Library 일과 여 핵종 부여 다. Analyze -> Background subtract 

(B)  진행 면 Subtract 에   일들에 포함 어 있는 모든 값들  

자동  빼주는 과 이다.  Analyze -> Quantify (Q)  진행 면 

Background Subtract, 효  용 등 모든 작업이 자동  실행 어 종 

사능 농도가 계산 다. 이 는 식 7  사용 다. 

 

                               (7) 

  

=감마 에 지 E 에  검출  계 효  
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Ap= 크  면  

Pγ=감마  출  

C= 원  자체 , 동시합 , 사 핵종  붕 시간 등에  보  

 

Pγ  헌 는 스펙트럼 분  그램 내에 장  library data 부  

얻   있다.  보  항 C 는  시료  리  태  검출 를 

포함   장  특  그리고 요구 는  도에 라 실험  는 

이  계산에 해 구해질  있다. 그 다  File -> Preview Spectrum 

Listing 에 들어가  Geometry, 효 용 일  일  여부, 시료채취 시작일, 

계  시작일  종료일, 시료 량, Library  Background 등이 모  맞게 

용 었는지 인 다. 

마지막  각 핵종별 사능 농도, 차, 검출 (MDA)를 인해주면 

모든 작업  료했다고 볼  있다. 이   사능  출 시간 부  

시간이 지난 후  값이므  감  인 여 사능이 감소  값  

보 해주  여 식 8  사용 여 계산 다.  

 

 

                           (8) 

 

 

여  A 는 재 사능, A0 는 사능 λ는 붕 상 , 그리고 t 는 

시간  미 다. 부분  핵종(137Cs, 60Co 등)들에 있어   감쇠보 식  

용 면 별 가 없지만 축차붕 를 는 핵종들(95Zr-95Nb, 140Ba-

140La 등)  해야 다. 냐 면 부분  상용  분  S/W 는  사능 

농도 계산 고리즘에 해  감쇠보   에 감 가 짧  핵종과 

축차붕 를 는 핵종  경우 사능농도가 크게 달라질  있다. 
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V. 결과  고찰 

 

1.  137Cs 분  신뢰도 검증결과 

 

Table  12.  Analysis results of 137Cs for KINS reference materials 

Soil           Material 

Year 
Measured values Reference values Evaluation 

2011 99.8±1.90 100 ±3.0 A (acceptable) 

2012 86.8 ±1.66 83.0 ±2.60 A (acceptable) 

 

Table 12는 2011 - 2012  사이에 KINS에  공 는 시료  137Cs  분  

결과를 나타내었다. 이들 값  토양 시료  감마 핵종 분  평가 인 원자

원회(IAEA)  AQCS(Analytical Quality Control Service)  평가 법에 라 

 값과 거  일 여, 본 실험  분  자료에  신뢰도를 인증 다

(KINS, 2011-2012). 
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2. 토양 시료  134Cs  137Cs 분  결과 

Table  13.  Specific activities of 134Cs and 137Cs in surface soil samples 

Sampled 

locations 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

Activity ratio 

134Cs/137Cs 

S1 11.96±0.62 62.56±1.53 0.19±0.01 

S2 16.73±0.72 26.84±1.09 0.62±0.04 

S3 6.38±0.47 108.62±2.1 0.06±0.004 

S4 <1.13 36.74±0.93 - 

S5 2.88±0.3 98.46±1.84 0.03±0.003 

S6 3.38±0.31 12.14±0.56 0.28±0.03 

S7 2.16±0.26 39.69±0.94 0.05±0.006 

S8 6.29±0.83 28.46±0.83 0.22±0.03 

S9 <1.04 17.50±0.58 - 

S10 2.87±0.27 53.62±1.15 0.05±0.005 

S11 13.90±0.72 78.87±1.87 0.13±0.01 

S12 5.47±0.63 58.95±1.65 0.13±0.01 

< : less than Minimum Detectable Activity( MDA) 

- : not calculation 

 

Table 13  주 지역  토양 미 경작지 토양  134Cs  137Cs 사능 농도  

134Cs /137Cs ratio  나타내었다. 134Cs 사능 농도는 S2가 16.73 Bq/kg-dry  가장 높

고, S7이 2.16 Bq/kg-dry  가장 낮 다. 그리고 S4  S9  경우 각각 0.934 

Bq/kg-dry, 0.561 Bq/kg-dry 주 극미량  사능 농도는 검출  값이 각각 

1.13 Bq/kg-dry, 1.04 Bq/kg-dry보다 게 검출 었다. 137Cs 사능 농도는 S3이 

109.62  Bq/kg-dry  가장 높 고, S6이 12.14 Bq/kg-dry  가장 낮 다.  Fig. 20   

134Cs  137Cs이  인 감마 핵종 스펙트럼  나타내었다. 
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a. 

 

 

b. 

 

Fig. 20.  Spectrum of (a) 137Cs and (b) 134Cs in surface soil samples. 
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3. 이끼 토양  134Cs  137Cs 분  결과  

Table  14.  Specific activities of 134Cs and 137Cs in soil attached moss samples 

Sampled 

locations 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

Activity ratio 

134Cs/137Cs 

S1 13.65±0.57 97.15± 1.99 0.14±0.01 

S2 30.67±1.14 46.56±1.63 0.66±0.03 

S3 19.54±1.08 79.97±2.31 0.24±0.02 

S5 12.46±0.72 20.26±1.06 0.62±0.05 

S6 9.28±0.56 26.94±0.97 0.34±0.02 

S7 8.27±0.43 127.20±2.53 0.07±0.003 

S8 29.09±1.35 30.61±1.68 0.95±0.07 

S9 2.61±0.21 4.40±0.34 0.59±0.07 

S10 7.66±0.34 39.35±0.94 0.19±0.01 

S11 27.28±0.99 106.64±2.55 0.26±0.01 

S12 12.91±0.67 36.62±1.19 0.40±0.02 

 

Table 14는 주 지역  이끼 토양  134Cs  137Cs 사능 농도  134Cs /137Cs 

ratio  나타내었다. 134Cs 사능 농도는 S2가 30.67 Bq/kg-dry  가장 높 고, S9가 

2.61 Bq/kg-dry  가장 낮 다. 137Cs 사능 농도는 S7이 127.20 Bq/kg-dry  가장 

높 고, S9가 4.40 Bq/kg-dry  가장 낮 다. 이끼 토양  134Cs/137Cs ratio는 

0.14~0.95 범 다. 

 

 

 

 

 



 

66 

 

4. 토양  이 별 134Cs  137Cs 분포 분  

 

Table  15.  Depth profiles of 134Cs and 137Cs in the soil of location S3 

depth(cm) 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

0 - 1 5.25±0.45 110.61±2.23 

1 - 2 2.92±0.42 120.92±2.41 

2 - 3 2.89±0.38 136.22±2.61 

3 - 4 - 158.47±2.97 

4 - 5 - 208.67±3.63 

5 - 7.5 - 254.80±4.22 

7.5 - 10 - 189.18±3.26 

10 - 12.5 - 87.33±1.78 

12.5 - 15 - 43.05±1.08 

15 - 17.5 - 15.56±0.63 

17.5 - 20 - 6.37±0.44 

20 - 22.5 - 3.32±0.36 

< : less than Minimum Detectable Activity( MDA) 

- :  N.D (not detectable) 

Table 15는 S3 조사 지 에  토양 이에 른 사  슘  분포를 인

 해 지 에  25 cm 이 지 분  결과를 나타내었다.  Fig. 23  (c)  

Fig. 22  (a)를 보면, 134Cs  0~3 cm 지만 검출 고 있 며 면 137Cs  7.5 cm

지 사능 농도가 증가 는 양상  보이다가 다시 감소 는 것  볼  있었다. 

이러  것  체르노  원 사고나 핵실험  137Cs이 존재 고 있  인  

 있었고, 핵종이 이나  등  향   차 지 에   이동 고 

있는 것  보인다. 그리고 후쿠시마 원 사고  인 여 토(약 ~3 cm)에 
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주 극미량 향   것  생각 어진다. 지만 134Cs  경우는 감 가 짧

 이  사고들  향들  재 지 존재 지  에 후쿠시마 원 사

고  향  0-3 cm 지만 검출  것  보인다.  
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Table  16.  Depth profiles of 134Cs and 137Cs in the soil of location S5 

depth(cm) 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

0 - 1 2.99±0.34 151.02±2.72 

1 - 2 - 164.80±3.02 

2 - 3 - 162.55±2.97 

3 - 4 - 168.67±3.01 

4 - 5 - 142.35±2.61 

5 - 7.5 - 79.08±1.55 

7.5 - 10 - 32.55±0.91 

10 - 12.5 - 9.33±0.52 

12.5 - 15 - 3.36±0.42 

15 - 17.5 - 1.98±0.35 

17.5 - 20 - 1.26±0.37 

20 - 22.5 - 1.08±0.48 

22.5-25 - 2.69±0.59 

< : less than Minimum Detectable Activity( MDA) 

- :  N.D (not detectable) 

 

 Table 16는 S5 조사 지 에  토양 이에 른 사  슘  분포를 인

 해 지 에  25 cm 이 지 분  결과를 나타내었다. Fig. 22  (b)  보

면 137Cs  경우 4 cm 지 증가 다 다시 감소 는 경향  보 고, Fig. 23  (d)를 

보면 134Cs  경우는 1 cm 지 에 만 검출 었는데, 이러  것  S3과 다른 경향

 보이고 있었는데 S3 조사 지  강우량이 S5보다  많  핵종  이동이 조

  히 일어난 것  보인다. 137Cs  체르노   핵실험  향  

재 핵종이 이동 고 있는 상황이고 토에는 후쿠시마  향이 해진 것

 보인다. 134Cs  경우는 후쿠시마  향   검출  것  단 다.  Fig. 



 

69 

 

21  일본에   토양 이에 른 사  슘  농도를 나타낸 것이다.  

우리나라  달리 직  입  사능 량이 주 많  후쿠시마 원 사고 

이  향이 주 어 토에 부  차 어드는 경향  보이고 있었다. 

지만 사  슘  분포 특  우리나라  5 cm이 에  경향과 사  

것    있었다. 라 , 우리나라 토양  0-5 cm 지는 후쿠시마 원 사고  

향   핵종이 거동 고 있어 일본과 달리 지속  감소 는 경향이 

닌 그래  나타나는 것  사료 다.   

 

 

 

Fig. 21.  Depth distribution of 137Cs and 134Cs activity concentrations in Kawamata 

Town, Japan. 
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Fig. 22.  Depth distribution of 137Cs activity concentrations in (a) S3 and (b) S5, Jeju. 
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Fig. 23.  Depth distribution of 134Cs activity concentrations in (c) S3 and (d) S5, Jeju. 
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5. 이끼 시료  134Cs  137Cs 분  결과 

Table  17.  Specific activities of 134Cs and 137Cs in moss samples 

Sampled 

locations 

134Cs 

(Bq kg-1–dry) 

137Cs 

(Bq kg-1–dry) 

Activity ratio 

134Cs/137Cs 

S1 21.71±0.85 23.83±1.06 0.91±0.05 

S2 27.15±1.38 26.10±1.70 1.04±0.09 

S3 16.54±1.04 20.03±1.33 0.82±0.08 

S4 13.62±1.21 19.34±1.39 0.70±0.08 

S5 28.99±1.24 31.42±1.57 0.92±0.06 

S6 39.00±1.70 40.91±2.20 0.95±0.06 

S7 10.28±0.72 31.62±1.26 0.32±0.03 

S8 37.98±1.76 36.88±2.20 1.03±0.08 

S9 10.49±0.65 15.04±0.86 0.70±0.06 

S10 6.53±0.46 18.37±0.80 0.36±0.03 

S11 21.88±1.39 28.33±1.73 0.77±0.07 

S12 10.52±0.92 17.15±1.13 0.61±0.07 

 

이끼 시료에  137Cs 사능 농도는 Table 17에  보는  같이 S6에  

40.91 Bq/kg-dry  가장 높 고, S9에  15.04 Bq/kg-dry  가장 낮 다. 134Cs 

사능 농도는 S6이 39.0 Bq/kg-dry  가장 높 고, S10에  6.53 Bq/kg-dry  

가장 낮 다. 

여  후쿠시마 원 사고  향  단 는 134Cs  경우 동일  지역에

 채취  토양 시료에 해 상  채취량이 었  이끼 시료에  사능 

농도가  높게 조사 었고, 토양 에  검출  이  조사  지 에 도 

이끼 시료에 는 검출 는 것  인   있었다. 이러  것  사능 슘이

토양  착보다 이끼  착 는  도가  높  것  사료 다. 
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C.  

 

 

d. 

 

Fig. 24.  Spectrum of (c) 137Cs and (d) 134Cs in surface soil samples. 
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6.  토양  이끼 시료  134Cs/137Cs ratio 

 

 

Fig. 25.  Distribution of the activity ratio 134Cs/137Cs in surface soil and moss 

samples. 

후쿠시마에  출  134Cs/137Cs ratio  본 연구를 통해 분  값들과 

함 써 사  핵종들이 후쿠시마에  인 는 것임  시   있다. 

Fig. 25를 보면   있듯이 134Cs/137Cs 가 토양이 0.03-0.62  나타났

는데, 이는 후쿠시마 사고에 해 출   값  진 1에 해 낮  

이다. 즉 과거 체르노  원 사고 당시 출  137Cs이 재 지 토양에 남

 있는 것  생각 다. 체르노  원  사고 시 출  출량  134Cs

가 ~54 PBq, 137Cs이 ~85 PBq이었 며, 134Cs/ 137Cs ratio는 0.5~0.6 다. 

이끼 시료  경우는 0.32~1.04  나타나고 있는데, 토양에 해 이끼 시료에

 약 1에 근 는 값들이 많이 나타났다. 결 , 이끼  경우 후쿠시마 

사고 이  향이 미미  것  보여지  에 토양에 해 사  상 

사고 시 사  향 평가에 있어 용  시료  용  것이라 단 다.  
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7. 후쿠시마 원 사고  향 분  (토양) 

 

Table  18.  Estimation of Fukushima-originating 137Cs activity in surface soil 

Sampled 

locations 

Fukushima-originating 137Cs 

(Bq kg-1 –dry) 

Fraction 

(%) 

S1 13.1±1.0 20.9±1.7 

S2 16.1±4.8 59.9±18.0 

S3 7.9±1.0 7.3±0.9 

S4 1.7±0.5 4.6±1.4 

S5 3.1±0.4 3.1±0.4 

S6 3.6±0.4 29.8±3.6 

S7 6.9±1.1 17.4±2.8 

S8 6.1±0.9 21.4±3.2 

S9 <MDA - 

S10 8.0±1.1 14.9±2.0 

S11 18.1±1.9 22.9±2.5 

S12 9.0±1.4 15.3±2.4 

Average 7.8±1.7 18.1±5.6 

<  MDA : 소검출 사능 (Minimum Detectable Activity) 농도 이  값 

 

재 존재 는 137Cs 핵종  이  체르노  원 사고  핵실험 등에  인

었  뿐만 니라 이번 후쿠시마 원 사고  향도 해  그 농도가 134Cs에 

해 높게 나타나고 있다. 이끼 시료  134Cs/137Cs ratio 부  식 9를 이용 여 후

쿠시마 향  토양에 입  137Cs  계산  결과 Table 18과 같이 나타내었다. 

S11에  18.1 Bq/kg-dry  가장 높 고, S9에  검출  이  나타났다.   

 = 이끼시료                (9) 

 



 

76 

 

VI. 결   

 

본 연구는 고 도게르마늄(HPGe)검출 를 사용 여 주지역  토양  이

끼 시료를 채취 여 134Cs  137Cs   것이다. 토양에  사능 농도를 

조사  결과, 134Cs  2.16 ~16.73 Bq/kg-dry  검출 었고, 137Cs  12.14 ~ 109.62 

Bq/kq-dry  검출 었다. 체 평균  각각 51.87 Bq/kg-dry, 7.20 Bq/kg-dry이 다. 

이끼에  농도를 조사  결과, 134Cs  6.53 ~ 39.0 Bq/kg-dry가 검출 었고, 137Cs

 15.04 ~ 40.91 Bq/kq-dry가 검출 었다. 체 평균  각각 25.75 Bq/kg-dry, 20.39 

Bq/kg-dry이 다. 134Cs/137Cs ratio  해 본 결과, 토양  0.03 ~ 0.62, 이끼는 0.32 

~1.04  나타났다. 토양에 해 이끼  ratio값이 후쿠시마 원 사고 당시 출

 진 1에 근 는 결과를 보이고 있었는데, 이는 토양에  이  체르노

원  사고나 핵실험 등  향   많이   보여진다. 그리고 이

끼  ratio가 출 에 근  값들  많이 보이는 것  볼  이끼가 사  

상 사고 시 사  향 평가에 있어 용  시료  용  것이라 단 다.  

재 주지역 토양  137Cs 사능 농도에  후쿠시마 원 사고 부  인

 137Cs  분  결과 1.7 ~ 18.1 Bq/kg-dry  계산 었고, 체 평균 는 7.8 

Bq/kg-dry  나타났다. 토양  이 별 슘 농도를 인  여 지 에  25 

cm 이 지 분  결과, 137Cs  약 5~7.5 cm 지 증가 다 다시 감소 는 양상

 보 고, 134Cs  1~3 cm 지 분포 고 있었다. 

본 연구 결과 부  사  상 시 극미량  사  질이 출 어 경 

에 입 어 존재  경우 사  향 경 평가에 있어  토양 시료 채취 법

 개  요 과 이끼 시료가 사능 지  식 써  용  시료  용

어 질 것이라 다. 
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